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 Introduction  xi

Introducing Microsoft Outlook for 
Mac 2011

Microsoft Outlook for Mac 2011 is an electronic communication and personal information 
management application that can help you take control of your email Inbox, contacts list, 
and calendar—all with one attractive and consistent interface. From one place, you can 
store, organize, manage, and retrieve many types of information. With Outlook for Mac, 
you can:

● Send, receive, forward, and organize email messages.

● Include images and other multimedia files as attachments to email messages you 
send.

● Send files created with Microsoft Office or other applications to clients, coworkers, 
family, or friends.

● Preview file attachments received as email attachments from others.

● Filter out junk or spam email messages.

● Schedule events, such as appointments or meetings, including recurring events.

● Invite people to meetings and keep track of their responses so that you know who 
will attend.

● View upcoming events and get reminders for them.

● Store contact information, including phone numbers, email addresses, Web sites, 
and mailing addresses, for people you know.

● Maintain and organize tasks lists.

● Store information as notes.

● Search through email messages, calendar events, contacts lists, tasks, and notes to 
find the information you need when you need it.

In an enterprise environment, Outlook interacts with a Microsoft Exchange Server to 
provide unified communications services, including real-time presence and status in-
formation, specialized functionality for internal messaging, scheduling information, and 
many other useful features.



xii   Introduction

New Features
Part of the Microsoft Office for Mac 2011 suite of applications, Outlook replaces 
Entourage 2008 with a whole new look and powerful new features. Here’s a quick list of 
some of the ones you’ll find most useful:

● The Microsoft Office ribbon puts the features and commands you use most right at 
the top of the Outlook window, organized by tabs.

● A unified Inbox displays all of your incoming messages together.

● Conversations make it possible to view long email threads under a single subject.

● Displaying your calendar in meeting invitations makes it easy to see, at a glance, 
whether you’re free to attend a meeting.

● .PST import makes it easy to switch from the Windows version of Outlook to the 
Mac OS version.

● Mac OS X integration taps into standard Mac OS features such as Quick Look and 
Spotlight.

● The cleaner, more attractive interface makes it easier to work with your information.

Let’s Get Started!
Outlook for Mac 2011 offers many great features to help you work smarter and more ef-
ficiently with your email, calendar, contacts, tasks, and notes. But don’t just take my word 
for it. Dive in and see for yourself on the pages that follow.



 Modifying the Display of the Ribbon xiii

Modifying the Display of the Ribbon
The goal of the Microsoft Office working environment is to make working with Office 
documents—for example, Microsoft Outlook for Mac 2011 email messages—as intuitive 
as possible. You work with an Office document and its contents by giving commands to 
the application in which the document is open. All Office for Mac 2011 applications or-
ganize commands on a horizontal bar called the ribbon, which appears across the top of 
each application window whether or not there is an active document.

Toolbar

Spotlight Search

Ribbon

Commands are organized on task-specific tabs of the ribbon, and in feature-specific 
groups on each tab. In Outlook for Mac, commands generally take the form of buttons 
and lists.

Throughout this book, we discuss the commands and ribbon elements associated with 
the Outlook feature being discussed. In this topic, we discuss the general appearance of 
the ribbon, things that affect its appearance, and ways of locating commands that aren’t 
visible on compact views of the ribbon.

Dynamic Ribbon Elements
The ribbon is dynamic, meaning that the appearance of commands on the ribbon 
changes as the width of the ribbon changes. A command might be displayed on the rib-
bon in the form of a large button, a small button, a small labeled button, or a list entry. 
As the width of the ribbon decreases, the size, shape, and presence of buttons on the 
ribbon adapt to the available space.
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For example, when sufficient horizontal space is available, the buttons on the Home tab 
of the Outlook application window are spread out and you’re able to see the commands 
available in each group as large or wide buttons.

If you decrease the width of the ribbon, some buttons shrink and their button labels 
disappear.

Changing the Width of the Ribbon
The width of the ribbon is dependent on the horizontal space available to it, which de-
pends on these two factors:

● The width of the application window Resizing the application window to full size 
provides the most space for ribbon elements. You can resize the application win-
dow by dragging the resize handle in the lower-right corner of the window.

● Your screen resolution Screen resolution is the size of your screen display ex-
pressed as pixels wide × pixels high. The greater the screen resolution, the greater 
the amount of information that will fit on one screen. Your screen resolution op-
tions are dependent on your monitor. At the time of writing, possible screen 
resolutions range from 800 × 600 to 2048 × 1152. In the case of the ribbon, the 
greater the number of pixels wide (the first number), the greater the number of 
buttons that can be shown on the ribbon, and the larger those buttons can be. 
You can change the screen resolution in the Displays preferences pane of System 
Preferences.

Adapting Exercise Steps
The screen images shown in the exercises in this book were captured at a screen resolu-
tion of 1024 × 768 at 72 dots per inch. If any of your settings are different, the ribbon on 
your screen might not look the same as the one shown in the book. Specifically, the but-
tons you see might be represented by larger or smaller icons than those shown, with or 
without button labels.
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When we instruct you to give a command from the ribbon in an exercise, we do it in this 
format:

● On the Home tab, click the Reply button.

If the command is on a menu, we give the instruction in this format:

● On the Home tab, click the New button and then, in the menu, click Folder.

The first time we instruct you to click a specific button in each chapter, we display an im-
age of the button in the page margin to the left of the exercise step.

If differences between your display settings and ours cause a button on your screen to 
look different from the one shown in the book, you can easily adapt the steps to locate 
the command. First, click the specified tab. Then look for a button that features the same 
icon in a larger or smaller size than that shown in the book. If necessary, point to buttons 
to display their names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you 
read and work through the exercises in the book.
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Features and Conventions of  
This Book

This book has been designed to lead you step by step through all the tasks you’re most 
likely to want to perform in Microsoft Outlook for Mac 2011. If you start at the begin-
ning and work your way through all the exercises, you will gain enough proficiency to 
be able to create and work with email messages, calendar events, contact records, tasks, 
and notes. However, each topic is self-contained. If you complete all the exercises and 
later need help remembering how to perform a procedure, the following features of this 
book will help you locate specific information:

● Detailed table of contents Search the listing of the topics and sidebars within each 
chapter.

● Chapter thumb tabs Easily locate the beginning of the chapter you want.

● Topic-specific running heads Within a chapter, quickly locate the topic you want 
by looking at the running heads at the top of odd-numbered pages.

● Glossary Look up the meaning of a word or the definition of a concept.

● Keyboard Shortcuts If you prefer to work from the keyboard rather than with a 
mouse, find keyboard shortcuts in many places throughout the book.

● Detailed index Look up specific tasks and features in the index, which has been 
carefully crafted with the reader in mind.

You can save time when reading this book by understanding how the Step by Step series 
shows exercise instructions, keys to press, buttons to click, and other information.
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Convention Meaning
SET UP This paragraph preceding a step-by-step exercise indicates 

the practice files that you will use when working through 
the exercise. It also indicates any requirements you should 
attend to or actions you should take before beginning the 
exercise.

CLEAN UP This paragraph following a step-by-step exercise provides 
instructions for saving and closing open files or programs 
before moving on to another topic. It also suggests ways 
to reverse any changes you made to your computer while 
working through the exercise.

1

2

Blue numbered steps guide you through hands-on exercises 
in each topic.

1

2

Black numbered steps guide you through procedures in 
sidebars and expository text.

See Also This paragraph directs you to more information about a 
topic in this book or elsewhere.

Troubleshooting This paragraph alerts you to a common problem and pro-
vides guidance for fixing it.

Tip This paragraph provides a helpful hint or shortcut that 
makes working through a task easier.

Important This paragraph points out information that you need to 
know to complete a procedure.

Keyboard Shortcut This paragraph provides information about an available key-
board shortcut for the preceding task.

Command+B A plus sign (+) between two keys means that you must 
press those keys at the same time. For example, “Press 
Command+B” means that you should hold down the 
Command key while you press the B key.

Save

Pictures of buttons appear in the margin the first time the 
button is used in a chapter.

Black bold In exercises that begin with SET UP information, the names 
of program elements, such as buttons, commands, windows, 
and dialog boxes, as well as files, folders, or text that you 
interact with in the steps, are shown in black, bold type.

Blue bold In exercises that begin with SET UP information, text that 
you should type is shown in blue bold type.
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Using the Practice Files
Before you can complete the exercises in this book, you need to copy the book’s practice 
files to your computer. These practice files, and other information, can be downloaded 
from here:

http://aka.ms/651890/files

Display the detail page in your Web browser and follow the instructions for downloading 
the files.

Important The Microsoft Outlook for Mac 2011 program is not available from this Web site. 
You should purchase and install that program before using this book.

The following table lists the practice files for this book.

Chapter File
Chapter 3: Composing and Sending  
Email Messages

Images
Antelope Canyon.jpg
GC Clouds.jpg
GC Trees.jpg
Kaibab Plateau.jpg
LCRG.jpg
London Bridge.jpg
LP Aerial.jpg
San Juan Aerial.jpg
Stucco-100.jpg
Stucco-50.jpg

Movies
ExploringSedona.mp4
Gila Monster.m4v
GrandCanyonDayTrip.mp4

Other Files
Flyer.docx
More Message Text.textClipping

http://aka.ms/651890/files
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Chapter File
Chapter 3: Composing and Sending  
Email Messages (continued)

vCards
Ben Andrews.vcf
Josh Bailey.vcf
Kim Akers.vcf
Lisa Andrews.vcf
Maria Langer.vcf
Nancy Anderson.vcf

Chapter 6: Fine-Tuning Email Settings Coho Winery.jpg
Grapes.jpg

Chapter 9: Managing Contact Information Mike Entin.jpg
vCards

Ben Andrews.vcf
Josh Bailey.vcf
Kim Akers.vcf
Lisa Andrews.vcf
Maria Langer.vcf
Nancy Anderson.vcf

Chapter 10: Organizing Your Contacts List Ben Andrews.vcf
Josh Bailey.vcf
Kim Akers.vcf
Lisa Andrews.vcf
Michael Entin.vcf
Nancy Anderson.vcf

Chapter 11: Working with Contact Records April Reagan.vcf
Eric Gilmore.vcf
Kim Akers.vcf

Chapter 12: Tracking Tasks Report.docx
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Chapter File
Chapter 13: Taking Notes Phone Call Note.txt

Images
Antelope Canyon.jpg
GC Clouds.jpg
GC Trees.jpg
Kaibab Plateau.jpg
LCRG.jpg
London Bridge.jpg
LP Aerial.jpg
San Juan Aerial.jpg

Chapter 14: Using Shared Features Message Text.txt
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Getting Support and Giving 
Feedback

Errata
We’ve made every effort to ensure the accuracy of this book and its companion content. 
If you do find an error, please report it on our Microsoft Press site: 

 1. Go to www.microsoftpressstore.com.

 2. In the Search box, enter the book’s ISBN or title.

 3. Select your book from the search results.

 4. On your book’s catalog page, find the Errata & Updates tab

You’ll find additional information and services for your book on its catalog page. If you 
need additional support, please send an email message to Microsoft Press Book Support 
at mspinput@microsoft.com.

Please note that product support for Microsoft software is not offered through the 
addresses above.

Getting Help with Microsoft Outlook for Mac 2011
If your question is about Microsoft Outlook for Mac 2011, and not about the content of 
this Microsoft Press book, your first recourse is the Outlook for Mac 2011 Help system. 
You can find general or specific Help information by clicking the Help button (labeled 
with a question mark) located in the upper-right corner of the Outlook for Mac program 
window.

If your question is about Microsoft Outlook for Mac 2011 or another Microsoft software 
product and you cannot find the answer in the product’s Help system, please search the 
appropriate product solution center or the Microsoft Knowledge Base at:

support.microsoft.com

www.microsoftpressstore.com
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You can post questions and search previously answered questions at the Microsoft 
Answers community-based forums at:

answers.microsoft.com

In the United States, Microsoft software product support issues not covered by the 
Microsoft Knowledge Base are addressed by Microsoft Product Support Services. 
Location-specific software support options are available from:

support.microsoft.com/gp/selfoverview/

We Want to Hear from You
At Microsoft Press, your satisfaction is our top priority, and your feedback our most valu-
able asset. Please tell us what you think of this book at:

www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in advance 
for your input!

Stay in Touch
Let’s keep the conversation going! We’re on Twitter: http://twitter.com/MicrosoftPress.
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How to Download the Online Edition to  
Your Computer

In addition to reading the online edition of this book, you can also download it to your 
computer. First, follow the steps in the preceding section. After Step 7, do the following:

 1. On the page that appears after Step 7 in the previous section, click the Extras tab.

 2. Find “Download the complete PDF of this book,” and click the book title: 

A new browser window or tab will open. Your browser will either immediately be-
gin downloading the file or will display a dialog box you can use to instruct it to 
save the file in the default download location.

 3. When the file has finished downloading, locate it on your hard disk—it will likely be 
in your Downloads folder on your Desktop—and double-click its icon to extract the 
PDF file from the ZIP archive. 

 4. Double-click the book’s PDF file icon to open it in your default PDF reader 
application.

Note If you have a problem with your voucher or access code, please contact 
mspinput@microsoft.com, or call 800-889-8969, where you’ll reach O’Reilly Media, 
distributor of Microsoft Press books. 

mailto:mspbooksupport@oreilly.com
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 3 Composing and 
  Sending Email  
  Messages
In this chapter, you will learn how to
✔ Create messages.
✔ Format message text.
✔ Insert media in messages.
✔ Attach files to messages.
✔ Change message settings.
✔ Send messages.

Although Microsoft Outlook for Mac 2011 includes views for managing appointments, 
meetings, contacts, tasks, and notes, it’s most often used for sending and receiving email 
in Mail view. Email, which is short for electronic mail, has all but replaced old-fashioned 
printed and mailed letters for most business and personal communication. It’s much 
faster and cheaper to send email messages, so sending paper-based or so-called snail 
mail is becoming a thing of the past. In a world where many people are becoming con-
cerned about conserving resources, email, which is not usually printed, saves paper (and 
money spent on paper) and prevents waste. Whether you need to communicate about 
business or personal matters, email simply makes sense.

Email, however, can go beyond simple text communication. You can format your mes-
sages so they look good and are easier to read. You can include clickable hyperlinks to 
make it easy for recipients to go directly to Internet content you specify. You can also 
include images or attach other computer files. 

Tip In this chapter and throughout this book, we often refer to email messages as simply 
messages. When discussing other types of messages—for example, instant messages or text 
messages—we use those full terms.
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For example, you might compose a message to a client about a job proposal and attach 
a copy of the proposal as a Microsoft Word or Adobe PDF file for the client to review. 
You might also attach images of what your product looks like to help your client visualize 
what you’re writing about. A link to the product page on your company’s Web site would 
be a handy way to provide access to more information. Email makes all this easy.

You can also set options for email messages that are just not possible with paper-based 
mail. For example, you can set a message as high priority so the recipient knows it’s im-
portant. If a message has sensitive content, you can encrypt it. And if you want the re-
cipient to be certain that the message came from you, you can digitally sign it.

See Also For more information about security features for email, see the section titled 
“Securing Your Email” in Chapter 6, “Fine-Tuning Email Settings.”

In this chapter, you will use Mail view within Outlook for Mac to create, address, and 
compose messages. You will also include a custom signature, format message text, em-
bed images, and attach files. Finally, you will set basic options for your message and send 
it on its way.

Important You’ll use the messages you create in this chapter as practice files for exercises in 
later chapters of this book.

Practice Files Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete 
the exercises in this chapter are in the Chapter03 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Creating Messages
Creating an email message is a relatively straightforward process. You begin by display-
ing a message composition window and then provide the recipient addresses, subject, 
and content of the message.

If you have more than one email account configured in Outlook, a From pop-up menu 
appears in the message header. This menu includes all of the email accounts configured 
in Outlook and determines the return address for the message.

Tip If you use one email account far more often than others, you might want to specify that 
account as the default account for sending messages. You can set your default email account 
in Outlook preferences, as discussed in Chapter 6.

Outlook offers three different fields for addressing a message. You can find them in the 
message header of the message composition window:
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● To Enter the email address of the primary recipient in this field.

The primary recipient is the person or persons you expect to respond to the 
message.

● Cc Enter the email addresses for additional recipients to receive a copy of the 
message.

Cc stands for carbon copy. In the days before copy machines, typists would use car-
bon paper to make copies of documents as they typed them. The term cc is from 
that era; a carbon copy would go to each of the Cc recipients. In Outlook, a list of 
these recipients appears in this field for all recipients to see.

● Bcc Enter the email addresses for additional recipients to receive a copy of the 
message without others knowing they received it.

Bcc stands for blind carbon copy. This field works very much like the Cc field, but 
Bcc recipients are hidden in the recipients’ copy of the message. 

Tip By default, the Bcc field does not appear in the message form. To display it, on the 
Options tab of the message composition window, click the Bcc button.

You must have at least one email address in at least one of these fields. (You cannot send 
an email message without a recipient!) You can have any number of recipients in each 
field.

There are several different ways to enter a recipient’s email address in Outlook:

● Type the complete email address into the field.

Tip To type more than one email address in an address field, separate each address with 
a semicolon (;).

● Type part of a previously used address into the field. Outlook displays a list of match-
es as you type. You can then click the address you want to enter it into the field.

● Click the Contacts Search button on the right side of the address field and, in the 
Contacts Search pane that appears, search your Outlook contacts for the recipient. 
In the list of search results, click the To, Cc, or Bcc button to assign that recipient to 
an address field.

See Also You can learn more about working with the Outlook Contact features in Chapter 9, 
“Managing Contact Information.”

You enter the content of your message in the message body. This part of the window 
works like a little word processor with word wrap and formatting capabilities. You can 
enter as much text as you like in the message body. You can even paste in content from 
another document. You can also embed images right within the message body or attach 
files to the message.
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See Also Formatting text, embedding images, and attaching files are covered later in this 
chapter, in the sections titled “Formatting Message Text,” “Inserting Media in Messages,” and 
“Attaching Files to Messages.”

When you create a message, you have the option of sending it to its recipients or saving 
it as a draft. Saving it as a draft is a way to put it aside and finish it later if you get inter-
rupted while composing the message or if you need additional information you have to 
wait to get. Draft messages are saved into the Drafts folder, which is listed in the navi-
gation pane. You can open a draft message at any time to complete and send it—or to 
delete it if you change your mind about sending it.

In this exercise, you’ll open a message composition window and fill in the message head-
er with recipients and a subject. You’ll then enter a brief message in the message body. 
You’ll finish up by saving the message as a draft that you can finish in a later exercise.

SET UP You need the six vCard files located in the Chapter03/vCards folder and the 
More Message Text text clipping file in the Chapter03/Other Files folder to complete 
this exercise. Drag the vCard files into the Contact View window to add them to your 
address book. In the Outlook view switcher, click the Mail button to switch to Mail 
view. Then follow these steps.

 1. On the Home tab, click the Email button.

Keyboard Shortcut Press Command+N.

An empty message composition window opens.

 2. If the message header includes a From field, click it to display its pop-up menu. 
Then click the email account you want to use to send the message.

 3. In the To field, type maria@fourthcoffee.com.

 4. Press Tab to move to the Cc field.

Email
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 5. Type and. Outlook attempts to match what you typed with your contacts and dis-
plays results in the Contacts And Recent Addresses menu.

 6. Click Ben Andrews. His name is entered into the Cc field.

 7. In the Cc field after Ben’s name, type your email address.

 8. Press Tab. If your name and email address is in your contacts list, your email ad-
dress is replaced with your name. Otherwise, it appears as an email address.

 9. In the Options tab of the message composition window, click the Bcc button. A 
Bcc field appears in the message header beneath the Cc field. It appears for just 
this message.

See Also You can set Outlook preferences so the Bcc field appears in all message 
composition windows. The section titled “Setting Reading and Composing Options” in 
Chapter 6 explains how.

 10. On the right end of the Bcc field, click the Contacts Search button. The Contacts 
Search pane appears.

 11. In the search field at the top of the Contacts Search pane, type Kim. Kim Akers’s 
name appears in the list.

Bcc

Contacts Search
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 12. Click the Bcc button in Kim’s record to add her name to the Bcc field.

 13. In the Subject field, enter New Postcards.

 14. In the message body, type I just got back from a trip to the Grand Canyon and 
have two new photos to add to our postcard collection. Press Return twice and 
then type Grand Canyon Trees is a photo of the Grand Canyon.

As you can see, you enter text into the message composition window’s message 
body the same way you’d enter text into Word or any other word processor.

Because you’re not reading this book to get typing practice, copy and paste the 
remaining message text from a text clipping.

 15. In the Finder, double-click the More Message Text file to open it in a text clipping 
window.

 16. Press Command+A to select all text in the text clipping. Then press Command+C to 
copy it to the Clipboard. Switch back to the message composition window. Make 
sure the cursor is blinking after the word Canyon. Then press Command+V to paste 
the text in. 

As you can imagine, you can do the same thing with existing text in any kind of 
document to paste it from that document into a message.

 17. Examine the title bar of the message composition window.

The name of the window is now New Postcards. The subject of a message appears 
on the title bar unless the Subject field is empty. 

A dark red dot appears in the close button. This indicates that the message con-
tains unsaved changes.

 18. Click the close button. A dialog sheet appears, warning that you are closing a mes-
sage that hasn’t been sent.
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 19. Click Save as Draft. The message is saved and the window closes.

 20. In the navigation pane, click Drafts. The draft message you just saved appears in 
the item list.

 21. In the item list, select the draft message you just created. Its content appears in the 
reading pane.

CLEAN UP No clean-up steps are required. You are ready to continue to the next 
exercise.

Formatting Message Text
Outlook offers two options when it comes to text formatting:

● Plain Text is just that—plain text. No formatting options are available. All text ap-
pears in 12-point Consolas font in the message composition window. How it ap-
pears in a recipient’s email client software depends on how his or her software is 
configured.

● HTML is formatted text that uses hypertext markup language—the same for-
matting technique used for most Web pages. HTML gives you control over many 
aspects of a message’s formatting. Best of all, it’s understood by almost all email 
client software, so there’s a good chance that the formatting you include in your 
messages will be seen by the messages’ recipients.
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By default, Outlook is set up to create new messages in HTML format. You can switch to 
plain text on a message-by-message basis. If you always want to use plain text for the 
messages you write, you can set Outlook preferences to use plain text as the default for 
all new messages.

See Also You can learn how to set the default formatting option for new messages in the 
section titled “Setting Reading and Composing Options” in Chapter 6.

If you use HTML formatting for the messages you write, Outlook offers a wide range of 
formatting options for your message text:

● Change the font, font size, and color of text.

● Apply font styles such as bold, italic, underline, and strikethrough.

● Highlight text characters.

● Create bulleted or numbered lists.

● Adjust indentation.

● Set paragraph alignment.

● Set a background color or picture.

● Format text as a clickable hyperlink.

You apply formatting to message text in Outlook the same way you might apply format-
ting in Word or another word processor: select the text you want to format and then 
apply formatting. You can see the results immediately. If you don’t like what you see, you 
can use the Undo command to undo a formatting change.

In Outlook, you can apply formatting using five different interface elements:

● Message tab This tab on the ribbon in the message composition window includes 
buttons and menus you can use to apply basic character and paragraph formatting 
to selected text.

● Options tab This tab on the ribbon in the message composition window includes 
options for changing the background color or background picture of a message.
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● Fonts panel The Mac OS X Fonts panel offers a standard interface for setting font 
formatting options. You can display the Fonts panel by clicking Choose at the bot-
tom of the Font menu on the Message tab.

Important With the Fonts panel, you can apply any font installed on your computer to 
selected message text. If the font you apply is not installed on the message recipient’s 
computer, he or she will not see the message formatted as you intended.

● Format menu Using the commands on this menu’s submenus, you can apply all 
kinds of formatting to selected text in a message.
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● Keyboard shortcuts Many formatting options have keyboard shortcuts. Here’s a 
table for reference.

Command Keyboard Shortcut
Bold Command+B
Italic Command+I
Underline Command+U
Strikethrough Shift+Command+X
Increase Font Size Shift+Command+=
Decrease Font Size Command+- (Minus)
Left Align Shift+Command+[
Centered Shift+Command+\
Right Aligned Shift+Command+]
Increase Indent Command+]
Decrease Indent Command+[
Hyperlink Control+Command+K

In this exercise, you’ll open the New Postcards message you created in the previous exer-
cise and format the text. You’ll also experiment with background colors and pictures.

SET UP You need the Stucco-50 and Stucco-100 images in the Chapter03/Images 
folder to complete this exercise.

 1. In the navigation pane, click Drafts.

 2. In the item list, double-click the New Postcards message to opens it in a message 
composition window.

 3. On the Options tab, click the Format button. A confirmation dialog sheet appears, 
asking if you’re sure you want to turn off HTML formatting.

 4. Click Yes. The document’s text changes to 12-point Consolas font.

Format
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 5. With the cursor anywhere in the message body, examine the Message tab. All for-
matting options are unavailable (gray). You cannot use the ribbon commands to 
format plain text.

 6. Click the Format menu to display it. Almost all options are unavailable. You cannot 
use menus to format plain text.

 7. On the Options tab, click the Format button. The message window switches back 
to HTML mode. The text returns to 14-point Calibri font. You can now format it 
again.

 8. Select all the text in the message body.

 9. On the Message tab, click the Font arrow to display the menu.

 10. Click Verdana. The Verdana font is applied to all selected text.

 11. On the Message tab, click the Font Size arrow to display the menu.

Format

Font

Font Size
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 12. Click 12. The font size of all selected text is reduced to 12 points.

Tip Another way to set the font size is to type a value in the Font Size box instead of 
choosing from the menu, and then press Return.

 13. Select the words Grand Canyon Trees at the beginning of the second paragraph. 

 14. On the Message tab, click the Bold button. The selected text turns bold.

 15. On the Message tab, click the Font Color arrow to display the menu.Bold

Font Color
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 16. Click Dark Green. The dark green color is applied to the selected text, and the 
color on the Font Color button becomes dark green. You have not only applied the 
color but you have set the default color for the button.

 17. Select the words Grand Canyon Clouds at the beginning of the third paragraph. 

 18. On the Message tab, click the Bold button. The selected text turns bold.

 19. On the Message tab, click the Font Color button. The dark green color is applied 
to the selected text.

 20. Select the two paragraphs beginning with the bold words Grand Canyon. On the 
Message tab, click the Bulleted List button. The two paragraphs become indented 
bullet items.

Tip If a third bullet appears at an empty paragraph after the list, click to the right of it 
and click the Bulleted List button to reset that paragraph without bullets.

 21. Select the name Maria at the end of the message.

 22. On the Message tab, click the Font arrow to display the menu, and then click 
Choose. The Fonts panel appears.

 23. In the Family scrolling list, click Lucida Calligraphy. The font applied to the select-
ed text changes.

 24. In the Size box, enter 14. The font size of the selected text changes.

 25. On the Fonts panel title bar, click the close button to close it.

 26. On the Options tab, click the Background Picture arrow, and then click Choose 
from the menu that appears. A standard Open dialog sheet appears. Use it to navi-
gate to the Chapter03/Images folder.

 27. Click the Stucco-100 image file, and then click Open. The image is placed in the 
background of the message. Unfortunately, because the image is so dark, the text 
is difficult to read.

Bulleted List

Background 
Picture
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 28. On the Options tab, click the Background Picture arrow, and then click Choose. 
The Open dialog sheet that appears should point to the Images folder inside the 
Chapter03 folder.

 29. Click the Stucco-50 image file, and then click Open. The image replaces the origi-
nal image. Because it’s a lighter color, the text is legible.

 30. On the Options tab, click the Background Picture arrow, and then click Remove. 
The image is removed from the background.

 31. On the Options tab, click the Background Color button. A standard Mac OS 
Colors panel appears.

 32. In the Colors panel, use one of the color pickers to select a light color. The color is 
immediately applied to the background of the message, so you can see how it will 
look before you make a final decision.

 33. On the Colors panel title bar, click the close button to close it.

 34. Select the words Grand Canyon in the first paragraph.

 35. On the Message tab, click the Insert a Hyperlink button. A dialog sheet with a 
Link field appears.

 36. In the Link field, type http://www.nps.gov/grca, and then click OK. The selected 
text turns into a blue, underlined hyperlink, similar to what you might find on a 
Web page. Clicking this text opens web page of the URL you typed.

Background 
Color

Insert a 
Hyperlink
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 37. On the message composition window toolbar, click the Save button or press 
Command+S to save changes to the message.

CLEAN UP No clean-up steps are required. You are ready to continue to the next 
exercise.

Inserting Media in Messages
With Outlook, you can insert images, sounds, and movies into messages. You can do this 
in one of four ways:

● Media Browser You can use this feature to select a photo from your iPhoto library, 
an audio file from your iTunes library, or a movie from your Movies folder or iTunes 
library. This integration with Mac OS and popular Apple applications makes it easy 
to find and insert the media you want.

Important You must have Apple’s iPhoto application, which is part of the iLife suite of 
products, installed on your computer to use the Photo Browser to insert images in your 
email messages.

● Picture From File This command displays a standard Open dialog sheet that you 
can use to locate, select, and open an image file to insert.

● Copy and Paste As you might expect, you can copy and paste an image from an-
other application into an Outlook message body. This is a handy technique when 
the image is already open on your computer.

● Drag and drop Outlook supports drag-and-drop copying from the Finder. Just 
drag the icon for the media file you want to include from a Finder window into the 
message body to copy the file to the message.

Important You can only insert media into an HTML format message. HTML format is 
discussed in the section titled “Formatting Message Text” earlier in this chapter. If you want to 
include media files in a plain message, they must be attached. Attaching files is covered in the 
section “Attaching Files to Messages” later in this chapter.

When you insert a picture, the image appears embedded in the message body instead 
of as an attachment. Sounds and movies appear as attachments. If the message recipi-
ent has an email application that supports media in HTML messages, all media may ap-
pear in the body of the message, and sounds and movies can be played from within the 
message.

Save
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Inserting Media: Outlook vs. Entourage

If you’re upgrading from Microsoft Entourage to Outlook, you may notice that 
Outlook handles multimedia elements differently. In Entourage, inserted pictures, 
sounds, and movies appeared inline, within the message body. In Outlook, only pic-
tures appear within the message body; other multimedia appears as an attachment.

Microsoft made this change when it rewrote the message authoring code for 
Outlook 2011 to be more consistent with the way attachments are handled within 
other email applications. Keep in mind, however, that if the recipient’s email appli-
cation supports media in HTML messages—as Apple Mail does—the media might 
appear within the message, even if it is attached.

Tip It's a good idea to make sure that recipients can view or play back multimedia format 
files you share with them. Although each computer supports different file formats, the most 
commonly supported formats include JPEG, GIF, and PNG for images; MP3 for sound; and 
MPEG or QuickTime for movies.

In this exercise, you’ll use three different techniques to insert a number of multimedia 
elements into the draft message you created earlier in this chapter.

SET UP If you have iPhoto installed, you need the photo files located in the 
Chapter03/Images folder to complete some of this exercise. Drag all but the Stucco 
photos onto the iPhoto icon to copy them into iPhoto. If you have iTunes installed, 
you need the three movie files located in the Chapter03/Movies folder to complete 
some of this exercise. Drag the movie files onto the iTunes icon to copy them into 
iTunes. Quit both iPhoto and iTunes. Drag the Gila Monster movie to the Movies 
folder in your Home folder. Make sure you have access to the Chapter03 files from 
the Finder. Open the draft message you worked on in the previous exercise if it is not 
already open.

 1. Click after Maria in the last paragraph of the message and press Return twice.

 2. On the Message tab, click the Picture button to display the menu.

Picture
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 3. Click Photo Browser to open the Media Browser. If necessary, click the Photos 
button.

If you have iPhoto installed, the top half of the Media Browser is populated with 
your iPhoto library information. (If you don’t have iPhoto installed, skip to step 6.)

 4. Click Last Import to display the photos you imported for this exercise.

Important The image files may appear in a different order than what is shown here.

 5. Drag the GC Clouds photo from the Media Browser to the space at the end of the 
message body. The photo is pasted into the message body.

 6. On the Media Browser title bar, click the close button.

 7. Make sure the cursor is just to the right of the inserted image. Then, on the 
Message tab, click the Picture button to display its menu again.

 8. Click Picture from File. A standard Open dialog sheet appears.

Photos
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 9. Navigate to the Chapter03/Images folder, click GC Trees.jpg, and then click 
Open. The image is inserted into the message beneath the other image. (If you 
don’t have iPhoto installed, you can repeat this process to insert the GC Clouds 
image.)

 10. On the message composition window toolbar, click the Media Browser button. 
The Media Browser opens again.

 11. In the Media Browser, click the Movies button. The top half of the Media Browser 
displays the Movies folder and, if you have iTunes installed, an iTunes icon. 

 12. Click either Movies or iTunes to display movies in the bottom half of the window.

 13. Drag the Gila Monster movie from the Media Browser to the message body. The 
movie appears as an attachment in the message header.

 14. On the message composition window toolbar, click the Save button or press 
Command+S to save changes to the message.

CLEAN UP No clean-up steps are required. You are ready to continue to the next 
exercise.

Attaching Files to Messages
You can attach any kind of file to an email message to send it to a message recipient. 
This enables you to collaborate with coworkers on the creation of Microsoft Office docu-
ments, taking full advantage of its powerful commenting and change-tracking features. 
It also makes it possible to share any kind of file with someone else.

In addition to using the Media Browser to attach sounds and movies, which was cov-
ered in the previous section of this chapter, Outlook offers two ways to attach a file to a 
message:

● Attach command This button or command displays a standard Open dialog sheet 
that you can use to locate, select, and open the files you want to attach. This makes 
it possible to attach any file you can access from your computer.

● Drag and drop With Outlook, you can drag file icons from the Finder into a mes-
sage window. If the file is not an image file, it is automatically attached.

You can attach files to any message, whether it’s in HTML or plain text format. 
Attachments are added to the attachments list in the message header. 

Media Browser

Movies
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If you change your mind about an attachment, you can easily remove it before sending 
the message by simply selecting it and pressing Delete. The attachment is removed from 
the message but is not removed from its source location on disk.

File Attachment Considerations

You should keep in mind a few important things when attaching files to share with 
message recipients:

● Attaching a file does not guarantee that the recipient will be able to open 
it. When attaching a document created with a specific application, you may 
want to ask the message recipient whether he or she has software that can 
open it before attaching and sending it. If there’s any doubt about document 
compatibility, you might consider saving the document as a PDF—just re-
member that all editing capabilities will likely be lost.

● Consider file size when attaching any file—including the multimedia elements 
discussed in the previous section. Some email accounts have restrictions on 
incoming message sizes or mailbox size. If, for example, you attempt to send 
8 MB of attached files to an email account that can accept only 5 MB, that 
message will not be received. It’s often more practical to use FTP or some 
other file transfer option when sharing very large files.

● When attaching multiple files to an email message, you may want to use the 
built-in Mac OS compression feature to compress or “zip” the files into one 
archive. Not only will this make the total file size smaller, but it will keep the 
files together in one neat package.

In this exercise, you’ll attach a Word document to the draft message you’ve been work-
ing on throughout this chapter. You’ll also remove an attachment so it is not sent with 
the message.

SET UP You need the Flyer document located in the Chapter03/Other Files folder to 
complete this exercise. Make sure you have access to the Chapter03 files. Open the 
draft message you worked on in the previous exercise if it is not already open.

 1. On the Message tab, click the Attach button. In the Open dialog sheet that ap-
pears, navigate to the Chapter03/Other Files folder.

Attach



76   Chapter 3 Composing and Sending Email Messages

 2. Click Flyer, and then click Choose. The file is added to the attachments field in the 
message header.

 3. In the attachments field, click the Gila Monster movie file you attached in the 
previous exercise.

 4. Press Delete. The attachment is removed.

 5. On the message composition window toolbar, click the Save button or press 
Command+S to save changes to the message.

CLEAN UP No clean-up steps are required. You are ready to continue to the next 
exercise.

Changing Message Settings
Before sending a message, you might want to set additional message options for it. 
Outlook offers a number of useful settings, such as the following:

● Signature This is a predefined footer for the bottom of the message. Normally, it 
includes the sender’s name and contact information, but it can include any text you 
like. Signatures are optional, but you can set up Outlook so it automatically appends 
a signature to every message you write.

See Also Creating and managing signatures is covered in detail in the section titled 
“Working with Signatures” in Chapter 6.

● Security These features enable you to digitally sign or encrypt a message. This 
helps protect the message from unauthorized access. By default, new messages are 
neither digitally signed nor encrypted.

See Also Security features for email messages are covered in the section titled “Securing 
Your Email” in Chapter 6.

● Priority This setting offers one way to tell the message recipient how important 
the message is. By default, each message is set for normal priority, but you can also 
set it for high or low priority.
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It’s important to note that all of the message settings discussed in this part of the chap-
ter are completely optional. You might never use any of them. Or you might focus on 
those you find most useful. Explore them to see which ones can help you work better 
with Outlook.

In this exercise, you’ll insert a signature and set the priority for the draft message you’ve 
been working with throughout this chapter.

SET UP You don’t need any practice files to complete this exercise. Open the draft 
message you worked on in the previous exercise if it is not already open.

 1. If necessary, click to position the cursor at the very end of the message body, right 
after the second image, and then press Return twice. This inserts two empty para-
graphs at the end of the message.

 2. On the Message tab, click the Signatures button to display the menu. This menu 
includes the Edit Signatures command, as well as at least one signature.

 3. Click Standard. The standard signature is inserted at the cursor.

Important If you have not yet configured a signature, the Standard signature may 
appear as just two dashes. You can customize the Standard signature or create other 
signatures that will appear in the Signatures menu. Chapter 6 explains how.

Tip You can modify or delete an inserted signature just like any other message body 
text.

 4. On the Message tab, click the High Priority button. The button turns dark gray to 
indicate that it is selected.

Tip You can set a message to normal priority by clicking the selected priority button 
again to deselect it.

Signatures

High Priority



78   Chapter 3 Composing and Sending Email Messages

 5. On the message composition window toolbar, click the Save button or press 
Command+S to save changes to the message.

 6. On the message composition window’s title bar, click the close button. The window 
closes.

 7. In the navigation bar, click Drafts, and then click the New Postcards message 
you’ve been working with. You should see several things:

❍ In the item list, icons for attachments and high priority appear beneath the 
message time.

❍ In the reading pane, the message header includes attachment information.

❍ Beneath the message header, a note indicates that the message is high 
priority.

CLEAN UP No clean-up steps are required. You are ready to continue to the next 
exercise.
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Sending Messages
When your message has been addressed, composed, formatted, and fine-tuned as 
desired, it’s ready to send. Just click the Send button, and the message is sent to its 
recipients.

There are a few additional things to consider when sending an email message:

● If you don’t have an Internet connection, you cannot send the message. Instead, 
when you click the Send button, Outlook places the message in an Outbox that ap-
pears right above the view switcher. The message remains there until you are con-
nected to the Internet and it can be sent.

Tip If you plan on working with Outlook for an extended period of time while offline, 
choose Work Offline from the Outlook menu. This will avoid any error messages that 
might appear when Outlook tries to connect to the Internet. When Internet access is 
available, be sure to choose Work Offline from the Outlook menu to disable this feature. 
Outlook should immediately connect to the Internet to send and receive messages.

● Email travels quickly, but it won’t be received by the recipient until he or she checks 
email. So although a recipient sitting at his or her computer might receive a mes-
sage from you almost immediately after you send it, a recipient on vacation with-
out Internet connectivity might not receive your message until he or she returns a 
week or more later. Many people don’t check work-related email accounts during 
off-work hours or personal email accounts while at work. Be patient if you don’t 
get an immediate response.

● Spam filters on the recipient’s email server or within the recipient’s email client 
software could also prevent your message from reaching the recipient—or simply 
delay it until the recipient checks his or her Junk E-mail or Spam folder. Spam filters 
look for words and patterns within a message to identify potential spam content; 
no spam filter is perfect. Spam filters don’t normally notify senders when messages 
are marked as spam, so you might never know your recipient didn’t get the mes-
sage you sent.
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● If the email address you send a message to is incorrect, the message should bounce 
back with some sort of notification. This could be immediate if the information af-
ter the @ symbol is correct, or it could be several days later if the part after the @ 
symbol is wrong. Keep this in mind the first time you contact someone by email; if 
the message bounces back, chances are that you entered the email address incor-
rectly in Outlook or the address is old and the email account has since been closed.

Checking Names

The Check Names button, which appears on the Message tab, makes it possible to 
validate the names of message recipients before sending the message. The trouble 
is, this feature requires either a Microsoft Exchange account with EWS/HTTP services 
enabled or that an LDAP server be set up as part of your Outlook configuration. In 
addition, it requires that each recipient either have an account on your Exchange 
server or be listed in a configured LDAP server.

If you do not have an LDAP server configured, this feature will not work at all. If 
a recipient is not listed on a configured LDAP server, this feature will not work for 
that recipient.

After a message has been sent, it moves from the Drafts folder to the Sent Items folder. 
Once it is there, you can open it to consult it, resend it, or delete it. How long an item 
remains in the Sent Items folder depends on the type of account it was sent from and 
the settings for that account.

See Also You can learn more about working with email messages stored in Outlook in 
Chapter 5,”Organizing Your Inbox,” and about account settings in Chapter 6.

In this exercise, we’ll take a last look at the draft message we’ve been working on 
throughout this chapter before sending it out to its recipients.

SET UP You don’t need any practice files to complete this exercise.

 1. In Mail view, in the navigation pane, click Drafts, and then double-click the New 
Postcards message. The message opens in a message composition window.

Check Names
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 2. Note that although the email message includes four recipients, only one of them—
you in the Cc field—is valid. If you send the message with all recipients, you’ll likely 
get three error messages. If you prefer not to see these error messages, select the 
invalid addresses (maria@fourthcoffee.com, Ben Andrews, and Kim Akers) one at a 
time and press Delete to remove them. Be sure to retain at least one email address.

Tip If you’re curious about what happens when you send email to invalid addresses, you 
can leave all recipients in the message header. Shortly after sending the message you 
should begin to get “Undelivered Mail” messages.

 3. On the Message tab, click the Send button. The message window closes and the 
message is sent.

CLEAN UP No clean-up steps are required. Leave Outlook open if you are continuing 
to exercises in the next chapter.

Key Points
● You create email messages in a message composition window.

● You can use the Contacts Search feature of Outlook to address messages to 
recipients.

● A message can include plain or formatted text, images, and other attached files.

● You can save a message as a draft so you can finish it at a later time if you need to.

● You can insert a preconfigured signature at the end of your messages and set mes-
sage priority before sending.

● You need to be connected to the Internet to send a message; if you’re not con-
nected, Outlook will save the message in an Outbox until you are connected and 
the message can be sent.

Send
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archiving 122
automatic categories based on contacts 357
automatic replies to 106–109
basics 57–58
changing settings 76–78
COMMAND key for selecting multiple 127
composing preferences 143–144
content entry 59
creating 58–63
deleting 135–137
dragging into folders 123, 126
fields for arranging messages 115
formatting text 63–71
forwarding 101–103
inserting media 71–74
marking as junk 172
moving to folders 124
pictures in incoming 89
printing 103–106
reading 87–93
reading preferences settings 140–142
removing category from 120
replies to 98–101
retrieving 84–86
rules to process 160–166
saving as draft 60, 63
scheduling actions 153–159
scheduling meetings from 109–110
security 174–177
sending 79–81

to contact group 252–253
signatures 147–153
task creation from 49
task from 314
to send note 348
to send vCard 291–292
viewing list for Inbox 90
with meeting invitation 203

Drafts folder 60, 80
deleting email from 135
searches of 129

Drafts in Mail view 28
displaying 63
saving 60, 63
saving or discarding 35

dragging
appointments 197–198

between calendars 223
for attaching files 74
events between calendars 220
media from Finder 71
messages into Inbox folders 123
note contents 347
vCard file to contacts list 294

Due date
for tasks 49, 309, 310, 326
for task search filter 325

Due Today folder 322
Duration field

changing 195
for appointment 187–188, 189, 206

E
edit box

for folder name 124
for smart folder name 134

Edit Custom Arrangements dialog box 116
Edit Mailing List Rule dialog box 167, 169
Edit menu

Delete 220
Find and Advanced Find 323
Paste 374
Spelling And Grammar 371, 373, 374

Editor option, for calendar 226
Edit Rule dialog box 161, 163
Edit Schedule dialog box 153, 156, 158
Edit Signatures command 77
email accounts

adding 11–13
additional options 18–19
advanced settings 177–181

server settings 178
checking for mail in all 86
displaying list 124
information needed for manual configuration 18
listing messages from one 91
multiple

displaying items for single 29
Inboxes for each 87

Outlook for centralizing 5
selecting for sending messages 58
setting up 4–8



402  em-dash

F
Family category 120
fields

in contact record 236
adding 238

inclusion in printed Address Book 297
search for contacts 274
sorting contacts list by 262

file attachments. See attachments to email
file formats

for multimedia 72
importing and exporting 386–387

File menu
Import 7
Print 296, 330

file size, and attachment limitations 75
filters 114

clearing 322
cumulative 322
for searches 128–133

criteria 274–276
on Search tab 129
smart filters for saving 133
tasks 321–323

Finder 62, 293
drag and drop media from 71
dragging attachment into 95

First day of week setting 215
Flagged Contacts smart folder 277
Flagged field, for task search filter 325
Flagged filter 128
Flagged Items tasks, filtering 321
Flagged Mail smart folder 133
flagging items for follow-up 314–316
Folder Properties: Calendar dialog box, 

Permissions pane 228
Folder Properties dialog box, Permissions 

pane 224
folders

Address book 41
for calendars 221
creating 162
including in contacts search 274
for mailing list messages 168, 170
for organizing contacts 269–273

deleting 269, 273
from synchronization 301
moving records  between 271–272

for organizing tasks 318
Smart folders 277–279
Spotlight search of 366, 367

em-dash 379
.eml files 102
Empty Deleted Items Folder schedule 153

changing 156
encryption

certificate storage 245
of email 76, 175

en-dash 379
End date, for printed calendar 230, 232
Ends field

changing 195
for appointment 187

Ends time field
for meeting 194
for printed calendar 230, 232

Entourage 3
importing data from 386
vs. Outlook

inserting media 72
interface 25

upgrading from 5, 314
envelope icon 87, 90
error log window 85
error messages, incorrect email address and 81
errors, alert sound for 85
Eudora, importing data from 386
events on calendar. See also appointments; 

meetings
categories to control display 217
dragging between calendars 220

Excel Auto Web Publish action 155
exceptions for Autocorrect 378
Exchange accounts

adding 8–10
advanced settings for security 180
automatic replies from 106–109, 108
calendar visibility to others 213
creating folder for email 123
Delegates pane for Advanced settings 179
deleting messages 135
dragging message from Inbox to folder 123
folder synchronization 84
Outlook support for 4
sharing calendar between 224
troubleshooting setup 17

Expanded display for groups 118
expanded version of Print dialog box 230
expanding conversations

settings for 141
exporting data 386–389
Export window 388



Home tab on ribbon  403

groups of contacts 235, 250–254
deleting 254
hiding member information 253
permission to access calendar 225
saving 252

H
Has Attachment filter 128
header for printed address book 299
hiding

columns 120
in Task view 319

contact group member information 253
reading pane 92, 119, 260

High Priority filter 128
High Priority folder 322
High Priority Mail smart folder 133
Holiday category 120
holidays, importing 387–389
Home tab on ribbon 25

Appointment 189, 223
Attachment 101, 102
for Calendar view 37, 39

Today button 40
View Date button 40

Categorize 120, 265, 266, 269, 345, 359
Add New 357
Edit Categories 360

check boxes for task filtering 322
Contact 239
Contact Group 251
for Contacts view 42

Contact button 46
Email button 45

Delete 136, 273, 326, 329
Details 261
Email 253, 374
Filters 128, 129, 130–132, 322

Clear All Filters 129, 130
Date Received 130
Unread 130

Find a Contact 273
Follow Up 315

Clear Flag 329
Forward 101, 102, 291, 348, 349
Junk

Junk E-mail Protection 171, 173
Mark As Not Junk 172, 174

List 261
for Mail view 30

Email button 33, 60
Meeting 40, 109–110, 110, 193, 253
Move 124

folders for email 122–127
as search filter 129
creating 123
creating for email account 124
deleting 135–137, 136
deleting email from 136
dragging messages into 123, 126
moving messages to 124
restrictions on deleting 135
selected, blue as indicator 136
smart 133–134
synchronizing 122, 124, 127

Folders pane
for IMAP accounts 180

fonts for email message 34
default settings 145–147

font size 68, 69
changing 66

in notes 340
for email 147

Fonts panel 65, 69
footer for printed address book 299
forcing folder synchronization 124
Format menu 65, 67
formatting

email message text 63–81
notes 339–343
signature 151

Forward As vCard command 290
Forward button 101, 102
forwarding

email messages 101–103
HTML or plain text mode 144
setting options for 143

notes 348, 349
Free status, for calendar event 204
Friends category 120
From field

for meeting 191
for message 60

From filter, for searches 129
From pop-up menu, for selecting email account 58
Full Name field 18

G
General pane, in contact window 244
GIF file format 72
Google Gmail 4
Grammar check 371–376

limitations 374
grouping messages 114–120

custom arrangements for 116
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inserting 342
print preview 351

selecting to insert in email 71
in signatures 148, 150

IMAP (Internet Message Access Protocol) 4
IMAP accounts

advanced settings for security 180
automatic checks for new messages 153
deleting messages 135
dragging message from Inbox to folder 123
Folders pane 180
folder synchronization 84
Outlook support for 4
server settings for 179
settings for 142
setting up 12
support for folders on server 122

Important field, for task search filter 325
Import Complete page 16
importing

data 386–389
Entourage data 6, 14–16
vCards 291

Import option, in Welcome window 4
Import window 387
Import wizard 14
Inbox 28, 35, 87

messages remaining in 90
unread messages in 87
viewing list of messages 90

Inbox organization
basics 113–114
category assignment to messages 120–122
deleting messages and folders 135–137
filters for searches 128–133
with folders 122–127
with smart folders 133–134
sorting and grouping messages 114–120

Inbox zero 123
incoming mail. See email messages
Incoming server field, for email account 12
indented text 66
individuals. See users
INitial CAps panel for AutoCorrect exceptions 378
initials, AutoCorrect to expand 380
inserting

media in messages 71–74
page breaks 298
pictures in notes 342
signature in email 77, 149

Internet connection
dial-up 155
for running schedule 154
for sending email 79

Internet information for contacts 237
menu display 241

Home tab on ribbon, continued
Choose Folder 124
Copy To Folder 124, 126
folder name displayed in menu 125

New 26, 162
Folder 123, 124, 219, 222, 269, 346

Note 337
for Notes view 51

Delete button 53
Open Calendar 227, 228
Permissions 228
Picture 341

Picture from File 342
Read 90, 93
Reply 98, 99
Reply All 98
Rules 160
Send/Receive arrow 86
Send/Receive button 85
Task 310, 312
for Tasks view 47

Delete button 50
Follow Up arrow 49
Follow Up button 49
Task button 48

Unread 90, 93
Hotmail account 4
HTML (Hypertext markup language) 63–64

turning off formatting 66
HTML mode

font color for 146
font for 145, 147
setting as default for email 144
settings for 144

hyperlinks
formatting text as 66
in email 70
URLs converted to 379, 382

I
.ics (calendar data) calendar format file 110
identities, selecting when importing Entourage 

data 15
If area for rule 161, 163
Ignore Spelling command 376
images

for contacts 236, 243
embedded in incoming messages, download 

options 142
inclusion when printing message 104
in incoming email message 89
for message background 64, 69
in notes 339



meeting response window, opening  405

left alignment of text 66
Level pane, in Junk E-mail Protection dialog 

box 171
List address field, for mailing list rule 168
list pane, in Tasks view 47
list view, for calendar 217
Location field

changing 195
for appointment 186, 189, 206
for meeting 194

Location filter 129–130

M
Mac OS X dictionary, adding word to 373
Mac OS X Fonts panel 65
magnification of contact record picture 243
magnifying glass icon 288
Mailing List Manager 139, 167

displaying 169
mailing lists 167–170

Advanced pane 168
mail proxy server 17
mail server

POP account messages retained on 19
SSL for 12

Mail view 28–36
Categorize, Add New 358
deleting items from 135
keyboard shortcut for 24
ribbon 30
Spotlight search of 368

Manager category 120
managing email. See Inbox organization
Mark as read setting options 141
MBOX format text file 386
Media Browser 71, 74

opening 73
Photos pane 341–342

meeting invitations
declining 202
email message with 203
responding to 201–204

meeting invitees 185
email addresses for 191
field for list of 191
indicating importance of 199
manually setting response 193, 200
notice of meeting cancellation 196
response from 194

changes to 196
Meeting Response tab, Send 203
meeting response window, opening 201

Internet Message Access Protocol (IMAP) 4. See 
also IMAP accounts

invitees to meeting 185
email addresses for 191
field for list of 191
indicating importance of 199
manually setting response 193, 200
notice of meeting cancellation 196
response from 194

changes to 196
iPhoto 72
iSync application 300
italic text 66

AutoFormat for 379
Item Contains filter bar 133, 134
item lists 23, 32

font for 145
iTunes 72

J
JPEG file format 72
Junk category 120
junk email 140

blocking 171–174
deleting, maximum age setting for 173
in Mail view 29

Junk Email folder
deleting email from 135, 171
including in searches 129
reviewing messages in 172

Junk E-mail Protection dialog box 171, 173

K
Kerberos

for Exchange account authentication 9
keyboard shortcuts

for opening message composition window 60
for opening Outlook Preferences window 283
for text formatting 66
for views 24

L
last used filters, restoring 129
Launch Alias action 155
LDAP servers 246

for email address verification 283
and organizational information for contact 244
troubleshooting information access 45
for validating message recipient names 80



406  meetings

message text in the item list, color of 120
Method pop-up menu, for Exchange account 9
Microsoft Communicator 286

launching from contact record 287
Microsoft Exchange Server 4. See also Exchange 

accounts
calendar 185
support for folders on server 122

Microsoft Hotmail 4
Microsoft Mactopia Web site 6
Microsoft Messenger for Mac 286
Microsoft Office 286

copying text clipping to Clipboard 62
Microsoft Outlook icon 5
Microsoft Word, Flag for Follow Up command 47
Minimize button 35
minimizing ribbon 26
MobileMe accounts (Apple) 300, 303

contacts synchronized with 302
deleting messages 135
Folders pane 180
folder synchronization 84
Outlook support for 4
support for folders on server 122

Mobile Phone column, in contacts list 263
Modified field, for task search filter 325
month, filtering email for current 130
Month view 39

printing 230
movie, selecting to insert in email 71
moving

appointments 197
contact records  between folders 271
email messages to folders 124, 125

MP3 file format 72
MPEG file format 72
My Calendars heading 219
My Day application 382–386

opening 384
window 213, 355

N
Name format

for printed address book 297
names

for Calendar folder 222
for folders 125

changing 270
inclusion when printing message 104, 105
for rules 161
for smart folders 134

navigation pane 22, 23, 123
calendars in 219
in Calendar view 36

meetings 38, 185
canceling 196, 200
changing 198
converting appointments to 196
default reminder for 215
determining available times for participants 191
scheduling from email messages 109–110
modifying 195
scheduling 97, 191–195
setting options 204–210

Meeting tab on ribbon 26
Cancel 198
Decline 203
Scheduling 199
Send 192, 194
Send Cancellation 200
Send Update 196

Meeting window 38, 45
for group invitation 253
opening 40
Scheduling Assistant 194

green check for invitee 192
Menu bar 22, 23
menus, buttons to display 26
message body of email 32, 33
message composition window 31, 45, 58, 253

displaying 97
Message tab 64

Send 177
opening 35, 60, 374
Options tab 64

Bcc field 61
Security 174, 177

text entry in 62
title bar 62

Message field, for meeting 191
Message header for email 32, 33
Message menu, Attachments, Save 95
message reading window 32, 88, 91, 92

opening reply 98
Print button 104

messages. See email messages
message sender, viewing information 96–97
Message tab on ribbon 34

Attach 75
Check Names 80
for character and paragraph formatting 64
High Priority button 77
Insert a Hyperlink 70
for message composition window 31
Picture 72
plain text and 67
Reply button 35
Send 81, 100
Signatures 77



Outlook Data File format, importing  407

opening
attachment from within Outlook 94
Outlook, running schedule when 154

Open Other User’s Folder dialog box 227, 228
Open Outlook Contact icon 97
Options tab on ribbon

Arrangement, Custom Arrangements 116
Background Picture arrow 69
for background of message 64
for Mail view 35

Format button 67
for message composition window 31
Spelling 375

order of rules when running 162
Organization pane in Contacts view 45, 244
Organize tab on ribbon 25

All Read 90
Arrange By 114, 116, 261, 320, 344

Custom Arrangements 117
Make This The Default View 264
Restore to Defaults 120

in Calendar view 37
Categorize 345

Add New 357
Completed 321
for Contacts view 42
Conversations 91
Flagged Items 321
Grid 217, 218
List 218
for Mail view 30
Me 290
Me button 46
Month 218
for Notes view 51
Overdue 321
Reading Pane 259, 317, 343

Hidden 92, 119
Scale slider 217, 218
Sync 124, 127

and deleted messages 135
for Tasks view 47
Week 218

outgoing email. See email messages
Outgoing Server field, for email account 12
Outlook

checking for email 84
information types 22
opening attachment from within 94
predefined categories 265
search throughout 368
setting as default email application 7
views 24

Outlook Data File format, importing 386

clearing all displayed check boxes 267
in Contact view 41
in Tasks view 47, 317
in Notes view 51
Shared Calendars 227
showing new categories 357

Networking category 120
Newest on Top sort order 117
notes

category assignment 345
converting text to bulleted list 339
copy and paste 337
creating 335–338
dragging contents 347
font size change 340
formatting 339–343
forwarding 349
inserting pictures 342
about mailing list 168
about meeting 201
pasting clipping text into 364
pictures in 339
printing 348
saving 336, 338
sharing 348–351
sorting by Date Modified column 344
viewing and organizing 343–347

Notes lists 51
Notes pane, in contact window 245
Notes view 50–53, 336

displaying 52
keyboard shortcut for 24
Spotlight search of 368

note window 52, 336
closing 337
opening 337

numbered list, AutoFormat for 379

O
Office 2008 Identities folder, Entourage data in 14
Office Reminders

turning on 316
Office Reminders window 205–206, 208
Office ribbon 21. See also ribbon
.olm files

exporting 387
importing 386

On My Computer
Calendars 219
Inbox 122

creating folder for 123, 126
Open dialog sheet 73

for attaching files 74
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on printed note 348
on printed task list 331

paper clip icon 93, 95
paper copies, vs. electronic 103
paragraph formatting 64
Password field

for email account 12
for Exchange account 9

pasting. See also Copy and Paste
clipping text into note 364

PDF file format
for attachments 75
for message output 105
from Print dialog box 231

Permissions pane, for calendar 226, 228
Personal category 120
personal information for contacts 237–238

menu display 242
Phone List 299–300

printing 296
phone numbers

default format 240, 284
for contacts 236
format options 282
menu of fields 240

Picture from File command 71
pictures

for contacts 236, 243
embedded in incoming messages, download 

options 142
inclusion when printing message 104
in incoming email message 89
inserting in note 342
for message background 64, 69
in notes 339
in print preview of note 351
selecting to insert in email 71
in signatures 148, 150

plain text 63
default font and font size 145
font for 145
and grayed-out formatting options 67
settings for 144
switching to 64

PNG file format 72
POP accounts

advanced settings for security 180
automatic checks for new messages 153
dragging message from Inbox to folder 123
folders for 122
message storage on server 19
Outlook support for 4
server settings for 179
setting up 12

Post Office Protocol (POP) 4

Outlook default settings 22
for area code 282, 284
email account for replies or forwarded 

messages 144
email account for sending messages 58
font and font size for plain text 145
HTML for email 144
for menu button 27
reminder time for events 215
restoring for arrangement 120
restoring view to 114
for signature 148, 152

Outlook for Mac window 21
Outlook for Windows, importing data from 14
Outlook interface

basics 22–25
Calendar view 36–41
Contacts view 41–46
vs. Entourage 25
Mail view 28–36
Notes view 50–53
ribbon 25–27
Tasks view 46–50
troubleshooting appearance 22

Outlook menu
Preferences 144, 147, 181
Work Offline 79

Outlook Preferences window 283, 379
Accounts preferences pane 176, 177, 181
Calendar 214, 215
Fonts preferences pane 145, 147
General preferences 7
Reading preferences pane 144
Rules 160
Schedules 153
Signatures 148, 149

Outlook window
viewing messages in 32

Out Of Office Assistant 106, 108
Out Of Office status, for calendar event 204
Overdue field, for task search filter 325
Overdue filter 128
Overdue folder 322
Overdue Mail folder 133
Overdue tasks, filtering 321

P
page breaks in printed address book 297

inserting 298
page numbers

inclusion when printing message 105
on printed address book 297
on printed calendar 231

removing 232



Rules feature in Outlook  409

in Tasks view window 317
moving to bottom 92
opening attachment from 96

Received and Date Sent filter, for searches 130
Receive Mail action 155
Recently Completed folder 322
Recently Completed smart folder 328
record 236. See also contact records
recurrence dialog sheet 210
Recurrence option

for schedule 154
for task 309
for repeating calendar events 204

Recurring Schedule dialog box 158
recurring series of appointments, deleting 210
recurring tasks 328
Reference Tools panel 355, 362, 364
reminder

for Birthday field 243
for calendar event 204
permanently dismissing window 205
for task 309, 310, 326

removing. See deleting
Repeating Schedule 154
Replace text as you type option for 

AutoCorrect 377
replies to email 98–101

discarding 100
HTML or plain text mode 144
including original message text 99
setting options for 143

request for an RSVP option, for calendar event 204
responding to meeting invitations 201–204

changing 202
response from meeting invitees 194

changing 196
manually setting 193, 200

restoring last used filters 129
reverse sort order 116
Reviewer option for calendar 226
ribbon 21, 23, 25–27. See also specific tab names

in Calendar view 37
in Contacts view 42
in Tasks view 47
in Mail view 30
for message composition window 31
for message reading window 33
minimizing 26

right alignment of text 66
Rules feature in Outlook 123

for automatic email replies 107
for mailing lists 139
to process email messages 160–166
testing 166

preconfigured Outlook filters 128–129
preconfigured smart folders 133
predefined categories 120
predefined criteria, for message filters 114
presets for printing 104
preview

of message PDF 105
of printed message 105

Preview button, for attachment 94, 95
Previous Day button (My Day window) 384
primary calendars 219
Print dialog box

for calendar 230, 231
for contacts 296, 298
for messages 104, 105
for notes 350
for tasks 329–333
variations in display 104

printing
calendars 229–232
contact records 295–300
email messages 103–106
notes 348
tasks 329–333

priority
for email 76, 77
for grouping items 118
for tasks 309, 311

sorting list by 320
Private option, for calendar events 204
Progress window 85, 86
project management, categories and 314
projects 307
.pst files, importing 386

Q
Qualcomm Eudora, importing data from 386
Quick Look, for attachments 94, 96
QuickTime file format 72
quitting Outlook, running schedule when 154

R
read, email message marked as 90
reading email messages 87–93
reading pane 22, 23, 35

for contact information
General tab 246
group member list in 252

for incoming messages 88
hiding 92, 119, 260

in Task view 319
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Attachment 131
Company 275
displaying 131
Email 275
filters on 129–130
Flagged 276
Has Address 275
Has Phone 275
Modified 276
Name 275
Save 133, 277
Subject 131

Secure Sockets Layer (SSL), for mail server 12
security

for email messages 76, 140, 174–177
setting options for 142

Select an Identity pane 15
selected folders, blue as indicator 136
selecting

all text in text clipping 62
contact 42
email account for sending messages 58
multiple messages with COMMAND key 127
multiple records in contact list 266
text for inclusion in message reply 100, 102

Select User dialog box 225, 228, 229
Send All action 155
Send All schedule 153
Send an Instant Message icon 96
senders, blocking junk email from specific 171
Send Mail button 96

for contact record 97, 287
Send & Receive All schedule 153
Sent Items folder 80

deleting email from 135
including in searches 129

Sent Items in Mail view 28
Sent To filter, for searches 130
servers

advanced settings for email accounts 178
email folders on 122
LDAP 246

for email address verification 283
and organizational information for contact 244
troubleshooting information access 45
for validating message recipient names 80

mail
POP account messages retained on 19
SSL for 12

Settings button (My Day window) 383
sharing

calendars 224–229
removing 229

notes 348–351

Rules preferences pane 160
displaying 163

Run AppleScript action 155

S
Safe Domains pane, in Junk E-mail Protection 

dialog box 171
saving

appointment changes 197
contact record changes 249
contract groups 252
email attachment to disk 95
email message as draft 35, 60, 63
filters in smart folders 133
notes 52, 336, 338
Outlook preferences changes 144
search filters 277
smart folder changes 278
smart folder settings 133
tasks 49, 384

changes 327
Schedule Meeting button 97

for contact record 287
Schedules preferences pane 156

Next Run column 158
scheduling

actions 153–159
appointments 186–191
meetings 191–195

from email messages 109–110
Scheduling Assistant 226

field for meetings 191
Scheduling Assistant pane

options for changes 196
when changing meeting 199–200

Scrapbook 355, 362
ScreenTips 26, 287
search. See also Spotlight search

for contacts 273–276
for messages 114

canceling 130
filters for 128–133

saving
criteria in smart folders 133
filters 277

for tasks 323–325
search box, for Copy to Folder command 126
Search tab on ribbon 130, 366

Advanced 130, 134, 277, 278
All Contacts 274, 370
All Items 369
All Mail 131
All Tasks 323
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for appointment 187, 189
for tasks 326

Starts time field
for appointment 189, 206
for meeting 194

Start time, for printed calendar 230, 232
status bar 22, 23

item count for list on 125
Status option, for calendar event 204
street addresses

default format 283
options for 289
predefined formats 282

strikethrough text 66
style

for printed task list 330
for printed calendar 230, 231
for task list 332

subfolders, as search filter 129
Subject field

for appointment 186, 189, 206
changing 195
for email 32, 62
of forwarded message 101
for meeting 194
of reply 98
for task search filter 325

Subject filter bar 131–132
Subject filter, for searches 130
synchronizing contacts 300–303
synchronizing folders 122, 127

automatic vs. forcing 124
Sync Services 300

preferences pane 301
synonyms 365

T
tab-delimited text file 386

exporting 386, 389
tabs on ribbon 25. See also specific tab names
task lists 47

for current week 322
selecting fields to include 331

task name field 49
tasks

adding to My Day 384
creating 308–314
examples 307
filtering 321–323
flagging items for follow-up 314–316
marking as completed 50, 326
modifying and removing 326–329
options for printed calendar 230

shortcut keys. See keyboard shortcuts
for saving notes 336

Show in Groups command 116
Show Spelling and Grammar command 373
signatures 76, 147–153

creating 150
deleting 152
formatting 151
inserting 77
setting default 152

Signatures preferences pane 148
Size filter bar, closing 132
size of attached files, filter based on 131
size of font 34, 68, 69

changing 66
Smart folders 133–134, 277–279

in Contacts view 42
deleting 135–136
displaying list 137
in Mail view 29
in Notes view 51
preconfigured 133
saving settings 133
for tasks 321, 322
in Tasks view 47

S/MIME standard 175
Snooze button, for reminder window 205
Sort groups, for custom arrangement 118
sorting

Calendar list 217, 218
contact records list 258–264
contacts search result 282
messages 114–120

custom arrangements for 116
notes by Date Modified column 344
printed address book records 297
task list 317, 319

order for 47
spam. See junk email
spam filters 29, 79
Spelling check 371–376

limitations 374
Spotlight search 366–371
Spotlight search box 131
SSL (Secure Sockets Layer), for mail server 12
Standard signature 147

displaying 149
Start a Video Call icon 97
Start date

for meeting 194
for printed calendar 230, 232
for task 309
for task search filter 325

Starts field
changing 195
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Out Of Office 106, 109
Schedules 153, 156
Sync Service 301

Translation 362
Travel category 120
troubleshooting

connection problems 17–18
LDAP server information 45
Outlook window appearance 22
ribbon appearance 23

U
underline text 66
Undo command 35

for formatting changes 64
Unread field, for task search filter 325
Unread filter 128, 130–131
unread items 30
unread messages in Inbox 91
Updated Contacts smart folder 277
URLs, converting to hyperlinks 379, 382
User Name

for email account 12
for Exchange account 9

users. See also specific account types (email 
accounts; Exchange accounts; etc.); 
contacts

permission to access calendar 225

V
vCards 60

creating and sharing 290–295
desktop icon for 292
from another user, adding to contact list 290–291
opening in contact window 293

.vcf file extension 290
Verdana font 67
View menu

Columns 116, 119–120, 262
Me Contact 290
Scrapbook 362

views 24
Calendar view 36–41, 185, 216–218

appointment display 190–191
displaying 39
imported holidays displayed 388
keyboard shortcut for 24
meeting display 194
Spotlight search of 368, 370

Contacts view 41–46, 235, 314
displaying 44
keyboard shortcut for 24

tasks, continued
printing 329–333
recurring 328
search for 323–325
viewing 317–321

Tasks button (My Day window) 383
Tasks view 46–50, 308, 315

displaying 48
keyboard shortcut for 24
Spotlight search of 368

Task tab on ribbon
Categorize 311, 312
Mark Complete 327
Recurrence 312–313
Save & Close 312, 328
Save & Close button 49

task window 308, 310
opening 320, 327

Team category 120, 121
Tentative status

as meeting invitation response 201, 202
for calendar event 204

testing rules 162, 166
text clipping window 62
text for automatic email replies 107
text wrap, in printed task list 332
Then area for rule 161, 164
Thesaurus 362

displaying 364–365
Timed Schedule 154
Time zone

for appointment 188, 189
setting default for calendar events 215

title of task 309
Today button (My Day window) 384
to-do list 307. See also tasks
To field 59

for email 32, 60
for meeting 191, 194

toolbar 22, 23
for message composition window 31
for message reading window 33
My Day 383
Print button 104, 105

Toolbox 355, 362–366
Tools menu (Outlook), Accounts 8
Tools menu (Word), Flag for Follow Up 315
Tools tab on ribbon 25

in Calendar view 37
for Contacts view 42
Export 388
Import 387
Mailing Lists 169
for Mail view 30
for Notes view 51



yellow alert icon  413

Week view
printing 230
scaling window grid 217
switching to 218

Welcome To Outlook For Mac window 4
What’s New button 6

width of column
changing 264
in task list 319

Window menu
Categories 361
Error Log 85
My Day 383
Progress 85, 86

Windows Live ID account 286
Windows Live Messenger 97
Word document, flagging for follow-up 314
Work day ends setting 214, 215
Work day starts setting 214, 215
Work Fax column, in contacts list 263
Work Offline 79
Work Schedule, options for 214
Work week setting 214, 215
Work Week view 39

printing 230, 231
scaling window grid 217

wrapping text, in printed task list 332

Y
yellow alert icon 85

list view pane 244
reading pane display options 258
Spotlight search 368, 369–371

Day view 39
printing 230
scaling window grid 217

Mail view 28–36
Categorize, Add New 358
deleting items from 135
keyboard shortcut for 24
ribbon 30
Spotlight search of 368

Month view 39
printing 230

Notes view 50–53, 336
displaying 52
keyboard shortcut for 24
Spotlight search of 368

Tasks view 46–50, 308, 315
displaying 48
keyboard shortcut for 24
Spotlight search of 368

view switcher 21, 22, 23, 189
Contacts 314
resizing 24
Tasks 315

W
Web addresses, in contact record, opening 289
Web browser

launching to view Microsoft Mactopia Web site 6
opening from contact record 289

Web Search 362
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